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Preface
 

Purpose of This Guide
This guide describes the necessary setting methods and operation methods for using the following product:

- Systemwalker Desktop Keeper V14g (14.2.0)

The target readers of this guide are the users of Windows.

 
Readers

This guide is for readers who export files using the file export utility of Systemwalker Desktop Keeper.
This guide assumes readers have the following knowledge:

- General knowledge of PCs

- General knowledge of Microsoft® Windows

- General knowledge of the Internet

 
Structure

This guide consists of chapters1-4 and an appendix.

Chapter 1 Export Files and Folders Using File Export Utility

This chapter describes the methods of using the file export utility of Systemwalker Desktop Keeper.

2.1 Apply Off-line Policy

This chapter describes the methods of applying off-line policy.

Appendix A Appendix A Message List

This chapter describes the output messages of Systemwalker Desktop Keeper.

 
Location of This Guide

The location of this guide in the manuals of Systemwalker Desktop Keeper is as follows:

 
Manual Name Content

Systemwalker Desktop Keeper User's
Guide

This manual describes the summary and the operating environment of
Systemwalker Desktop Keeper.

Systemwalker Desktop Keeper
Installation Guide (Note 1)

This guide describes the installation settings, as well as the maintenance and
management measures of Systemwalker Desktop Keeper.

Systemwalker Desktop Keeper User’s
Guide: for Administrator (Note 1)

This guide describes how to use Systemwalker Desktop Keeper.

Systemwalker Desktop Keeper User’s
Guide: for Client (This Guide)(Note 2)

This guide describes the function summary and operation methods of Export
Utility of Systemwalker Desktop Keeper.

Systemwalker Desktop Keeper Reference
Manual

This manual describes the commands, files, messages and port numbers used
in Systemwalker Desktop Keeper.

Systemwalker Desktop Keeper
Troubleshooting Guide

This guide describes the causes and resolutions of assumed exceptions in
Systemwalker Desktop Keeper.

Note 1: Systemwalker Desktop Keeper Installation Guide and Systemwalker Desktop Keeper User’s Guide: for Administrators are
manuals for the administrators of Systemwalker Desktop Keeper.
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Note 2: Systemwalker Desktop Keeper User’s Guide: for Client can also be viewed from the “Help” menu of File Export Utility.

 
Notations

For the convenience of description, this guide uses the following names, symbols and abbreviations.

Symbols Used in Commands

This subsection describes the symbols used in commands.
Meaning of Symbol

 
Symbo

l
Meaning

[ ] Indicates that the items enclosed in these brackets can be omitted.

| Indicates that one of the items separated by this symbol should be selected.

Icons

The following icons are used in this manual.

 

 Note

The above icon applies to items requiring special attention.

 

 Point

The above icon applies to skills required for more efficient use of Systemwalker Desktop Keeper.

DTK Installation Directory

The DTK installation directory is the directory into which Systemwalker Desktop Keeper's products is installed.

Abbreviations

The manual uses abbreviations of the following products:

 
Product Name Abbreviation

Systemwalker Desktop Keeper Base Edition V12.0L10 BEV12.0L10

Systemwalker Desktop Keeper Base Edition V12.0L20 BEV12.0L20

Systemwalker Desktop Keeper Base Edition V13.0.0 BEV13.0.0

Systemwalker Desktop Keeper Base Edition V13.2.0 BEV13.2.0

Systemwalker Desktop Keeper Base Edition V13.3.0 BEV13.3.0

Systemwalker Desktop Keeper Standard Edition V12.0L20 SEV12.0L20

Systemwalker Desktop Keeper Standard Edition V13.0.0 SEV13.0.0

Systemwalker Desktop Keeper Standard Edition V13.2.0 SEV13.2.0

Systemwalker Desktop Keeper Standard Edition V13.3.0 SEV13.3.0

Systemwalker Desktop Keeper V14g (14.0.0) V14.0.0

Systemwalker Desktop Keeper V14g (14.0.1) V14.0.1
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Product Name Abbreviation

Systemwalker Desktop Keeper V14g (14.1.0) V14.1.0

Systemwalker Desktop Keeper V14g (14.2.0) V14.2.0

Microsoft® Internet Explorer® 6.0
Windows® Internet Explorer® 7
Windows® Internet Explorer® 8
Windows® Internet Explorer® 9

Internet Explorer®

The manual uses abbreviations of the following operation systems:

 
OS Abbreviation

Microsoft® Windows Server® 2008 Foundation
Microsoft® Windows Server® 2008 Standard
Microsoft® Windows Server® 2008 Enterprise
Microsoft® Windows Server® 2008 Standard without Hyper-V™

Microsoft® Windows Server® 2008 Enterprise without Hyper-V™

Microsoft® Windows Server® 2008 R2 Foundation
Microsoft® Windows Server® 2008 R2 Standard
Microsoft® Windows Server® 2008 R2 Enterprise
Microsoft® Windows Server® Small Business Server 2011 Essentials

Windows Server® 2008 (*)

Microsoft® Windows Server® 2003, Standard Edition
Microsoft® Windows Server® 2003, Enterprise Edition
Microsoft® Windows Server® 2003 R2, Standard Edition
Microsoft® Windows Server® 2003 R2, Enterprise Edition
Microsoft® Windows Server® 2003, Standard x64 Edition
Microsoft® Windows Server® 2003, Enterprise x64 Edition
Microsoft® Windows Server® 2003 R2, Standard x64 Edition
Microsoft® Windows Server® 2003 R2, Enterprise x64 Edition

Windows Server® 2003 (*)

Microsoft® Windows® 2000 Professional operating system
Microsoft® Windows® 2000 Server operating system
Microsoft® Windows® 2000 Advanced Server operating system

Windows® 2000

Microsoft® Windows® XP Professional
Microsoft® Windows® XP Home Edition

Windows® XP (*)

Windows Vista® Home Basic
Windows Vista® Home Premium
Windows Vista® Business
Windows Vista® Enterprise
Windows Vista® Ultimate

Windows Vista® (*)

Windows® 7 Ultimate
Windows® 7 Enterprise
Windows® 7 Professional
Windows® 7 Home Premium

Windows® 7 (*)

Microsoft® Windows® Millennium Edition Windows® ME

Microsoft® Windows® 98 Second Edition Windows® 98

Microsoft® Windows® 95 operating system Windows® 95

*) To record the location of saving commands and files differently, especially in case of x64 Edition, use the following abbreviations.

- Windows Server® 2008 64-bit Edition

- Windows Server® 2008 R2

- Windows Server® 2003 x64 Edition
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- Windows Server® 2003 R2 x64 Edition

- Windows® XP 64-bit Edition

- Windows Vista® 64-bit Edition

- Windows® 7 64-bit Edition

 
Export Restriction

Our documentation may contain certain technologies subject to regulation by the Foreign Exchange and Foreign Trade Control Law.
Export of any documents that contain such technologies and supply of such documents to any nonresident require an appropriate export
license under the above law.

 
General Restriction

The following functions are recorded in this manual but cannot be used.

(These functions can be used in the Japanese version, but are not available in English and Chinese versions.)

- Prohibition Function

- Encryption Function in File Export

- Encryption Function in E-mail Attachment

- Logon Prohibition Function

- E-mail Attachment Prohibition Function

- E-mail Recipient Address Confirmation Function

- USB Device Individual Identification Function

- Record Function

- Command Prompt Operation

- Citrix XenApp Monitoring Function

- Others

- Notification to Client

- All-in-one Machine Linkage Report

In addition, for the specification of characters recorded in this manual, please pay attention to the following points:

- For character code, please replace Shift-JIS with local character code (character code that corresponds to the code page on OS).

- Please replace ”Japanese” or ”Double-byte” with multi-byte character.

- For number of characters that can be used, multi-byte characters such as double-byte in this manual are calculated as 2 bytes, but when
actually saving to database, one character may occupy 2~6 bytes, please pay attention.

The following versions do not exist, please ignore relevant record.

Systemwalker Desktop Keeper Base Edition V12.0L10

Systemwalker Desktop Keeper Base Edition V12.0L20

Systemwalker Desktop Keeper Base Edition V13.0.0
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Systemwalker Desktop Keeper Base Edition V13.2.0

Systemwalker Desktop Keeper Base Edition V13.3.0

Systemwalker Desktop Keeper Standard Edition V13.2.1

Systemwalker Desktop Keeper Standard Edition V13.3.0

Systemwalker Desktop Keeper V14g (14.0.0)

Systemwalker Desktop Keeper V14g (14.0.1)

Systemwalker Desktop Keeper V14g (14.1.0)

For example, when it is described as “V13.3.0 or later”, since V13.3.0 does not exist, please replace it with “V14.2.0 or later. In addition,
when it is described as ”V14.0.0 or earlier”, please replace it with “V13.2.0 or earlier” for the same reason.

 
Trademarks

Microsoft, Windows, Windows NT, Windows Vista, Windows Server and other Microsoft product names are trademarks or registered
trademarks of Microsoft Corporation in the United States and other countries.

Other product names are trademarks or registered trademarks of their respective holders.

Screenshots are used according to the guidelines of Microsoft Corporation.

March 2012

 
Revision History

March 2012 First Edition

Copyright 2005 - 2012 FUJITSU LIMITED
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Chapter 1 Export Files and Folders Using File Export Utility
This chapter describes the following operation method.

- Use File Export Utility to export files and folders from the client (CT).

1.1 Start File Export Utility
In a PC with the client (CT) of Systemwalker Desktop Keeper installed, the export of files and folders may be restricted (prohibited) due
to the policy settings. At this time, files and folders cannot be exported through Explorer.

When exporting files from the prohibited drive, the following error message will be displayed in the client (CT).
[Examples of messages displayed when files are exported from the prohibited drive through Explorer]

Under Windows® XP

Under Windows Vista®

In addition, the following operations for the prohibited drive will not be prohibited:

- Create a new folder

- Copy a folder (But the files under the folder cannot be copied)

- Delete a folder (But the files under the folder cannot be deleted)

- Delete fills on removable drive and network drive

To export files and folders, the File Export Utility should be used.

By using the Export Utility, files and folders can be exported from the drive of a PC with Systemwalker Desktop Keeper client (CT)
installed to removable media, etc.
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The maximum length of the path (full path) of the export source file name that can be specified is 218 characters.

The following describes how to start the File Export Utility and its window layout.

 
Startup

This section describes how to start the File Export Utility.

1. Start File Export Utility with any of the following methods.

- Select [Programs] - [Systemwalker Desktop Keeper] - [Client] - [File Export Utility] from the [Start] menu of the PC on which
the client (CT) is installed.

- Right-click a file or folder in Explorer, and select [Send to] - [Desktop Keeper File Export Utility].

- Drag the file or folder to the icon of [Desktop Keeper File Export Utility] on desktop.

→ The [File Export Utility] window is displayed.

Displayed Content of Window

This section describes the name of components in the [File Export Utility] window.

File Export List

Display the list of files or folders exported from the client (CT).

Menu Bar/Tool Bar

The following describes the menu bar and tool bar of the [File Export Utility] window.

 
Menu Bar Tool Bar Function Summary

[File]

[Add file]

Add file

Display the file selection window. Select the file(s)
to be exported.

[Add folder]

Add folder

Display the folder selection window. Select the
folder(s) to be exported.

[Delete file]

Delete file

Delete the files or folders displayed in the file export
list.
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Menu Bar Tool Bar Function Summary

[Execute export]

Execute export

Export unencrypted or encrypted files and folders.

[Format Drive] － Format the drive.
This option appears depending on the policy
settings.

[Erase CD-RW/
DVD-RW]

－ Erase all data of the CD-RW/DVD-RW media. 
It is displayed when the client (CT) uses an OS that
can erase CD-RW/DVD-RW.
This option appears depending on the policy
settings.

- The OS that can erase the CD-RW media data
are as follows. (*)

- Windows Vista®

- Windows® 7

- Windows® XP

- The OS that can erase DVD-RW media data are
as follows. (*)

- Windows Vista®

- Windows® 7

[Exit application] － Exit the Export Utility.

[Display]

[Display in Full
Path ]

Display in Full Path

Switch between whether to display the full path of
the file export list or not.

[View export
destination]

View export target

Display the [View export destination] window.
File Export Utility can be used to view the files
exported to USB devices (the list of drives, files and
folders can be viewed).

[Help]

[Online Help]

Online Help

Display online help.

[Version
Information]

－ Display copyright and version information.

*) The OS is shown as follows.

- Windows® 7 Ultimate

- Windows® 7 Enterprise

- Windows® 7 Professional

- Windows® 7 Home Premium

- Microsoft® Windows® XP Professional(ServicePack2 or later)

- Microsoft® Windows® XP Home Edition(ServicePack2 or later)

- Windows Vista® Home Basic

- Windows Vista® Home Premium

- Windows Vista® Business

- Windows Vista® Enterprise
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- Windows Vista® Ultimate

Export Method Selection Button

Depending on policy settings, the export method selection button may not appear sometimes.

 
Item Name Description

[Normal Export] Files and folders can be exported directly.

[Excrypted Export] Files and folder can be exported after encryption.

Input Field of Reasons for Export

Depending on policy settings, the input field of reasons for export may not appear sometimes. 
When the input field of reason for export appears, please make sure to input. 
Up to 200 bytes can be input as the reason for export. Line feeds and tab cannot be input.

1.2 Export File
The following describes the situations when exporting files to media other than DVD/CD, and when exporting files to DVD/CD media.

1.2.1 Export file to media except DVD/CD
The following describes the procedure of using File Export Utility to export files or folders to a removable drive.

 

 Note

Please confirm the status of file

- Please do not access the file that is being exported through the export utility from another application. When the file in the export
process is being accessed, an error may occur.

- When decrypting the file in the export destination, the OS operation authority is required for encrypting files, and files cannot be
decrypted without operation authority.

 

 Note

When executing export to the folder with writing restriction in the OS of Windows Vista® or later

When export to the folder with writing restriction is executed using the Export Utility in the OS of Windows Vista® or later, writing will
not be performed, but the files will be placed into “%LOCALAPPDATA%\VirtualStore”.

Example: C:\Users\User NameAppData\Local\VirtualStor

The procedure is as follows.

1. Start the [File Export Utility] window.
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2. Add the file or folder to be exported with any of the following methods.

- Use the menu of the [File Export Utility] window

a. Select [Add file] from the [File] menu to export a file.
Select [Add folder] from the [File] menu to export a folder.

→The file selection window is displayed.

b. Select the file or folder to be exported and click the [Open] button.

Repeat a and b to export multiple files.

- Drag and drop the file or folder to the [File Export Utility] window.

 

 Note

When executing in Windows Vista®, Windows Server® 2008 and Windows® 7

In Windows Vista®, Windows Server® 2008 or Windows® 7, if right-click on [Execute as Administrator] when starting the
File Export Utility, drag and drop cannot be performed. But when the administrator logs on, even if it is started through [Execute
as Administrator], drag and drop can be performed.

→The [File Export Utility] window is displayed.

When folder export is selected, the total size of files under this folder will be displayed in [Size].

3. When the input field of reasons for export is displayed, enter the reason.

4. Select [Execute export] from the [File] menu.
Depending on the policy settings, sometimes only removable disks are displayed as options for the destination drive.

5. Click the [OK] button on the execution confirmation window.
The following describes the operations in the situation [When files and folders are exported directly].

[When files and folders are exported directly]

→ The [Select target for normal file export] window is displayed.
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a. Select the target to be exported, and click the [OK] button.

b. The following window will be displayed after the file export has finished (the window indicating the executing operation
will be displayed when the processing time is relatively long). Click the [OK] button.

1.2.2 Export File to DVD/CD Media
This section describes the procedure for using the file export utility to export files and folders to DVD/CD.

 
OS that allows export

The OS that can export files to CD media are as follows:

- Windows® 7 Ultimate

- Windows® 7 Enterprise

- Windows® 7 Professional

- Windows® 7 Home Premium

- Microsoft® Windows® XP Professional(ServicePack2 or later)

- Microsoft® Windows® XP Home Edition(ServicePack2 or later)

- Windows Vista® Home Basic

- Windows Vista® Home Premium

- Windows Vista® Business

- Windows Vista® Enterprise
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- Windows Vista® Ultimate

The OS that can export files to DVD media are as follows.

- Windows® 7 Ultimate

- Windows® 7 Enterprise

- Windows® 7 Professional

- Windows® 7 Home Premium

- Windows Vista® Home Basic

- Windows Vista® Home Premium

- Windows Vista® Business

- Windows Vista® Enterprise

- Windows Vista® Ultimate

 
Conditions of DVD/CD that allows export

- Types of the media that can be exported: CD-R, CD-RW, DVD-R, DVD-RW

- Status of the media that can be exported: blank media

Blank media refers to the following.

- Unformatted CD-R/RW or DVD-R/RW media after purchasing. However, the specific circumstance when the media has already been
formatted should be excluded.

- The CD-RW/DVD-RW media that has been burned but erased with the Export Utility.

The CD-R, CD-RW, DVD-R and DVD-RW that are formatted by the following methods cannot be used as the media that allows export
even if no file exists after formatting.

- When the disk is formatted to UDF for packet writing

- When the disk is formatted to CDFS for streaming writing

 
Erase DVD-RW/CD-RW

When erasing the data existing in a DVD-RW/CD-RW media and exporting files to that DVD/CD, please use the File Export Utility to
erase data. The steps of erasing data are as follows.

1. Start the [File Export Utility] window.
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2. Select [Erase CD-RW/DVD-RW] from the [File] menu.

→ The [Erase media] window is displayed.

3. Select a DVD/CD drive that contains the media for data erasing, and then click the [Erase] button.

→ The [Erase media (Drive)] window is displayed.

- When erasing DVD/CD quickly
→Select [Quick Erase]. Quick erase means only to erase the PMA(Program Memory Area) and TOC(Table Of Contents) field.

- When erasing DVD/CD completely
→Select [Complete Erase]. Complete erase means to erase all fields of the DVD/CD.

- When updating the DVD/CD information displayed in the window
→Click the [Refresh media] button. The [Total DISK Capacity] and [Volume Name] of DVD/CD will be displayed again.

4. Select the method of erasing a DVD/CD, and click the [Start erasing] button.

→ The following confirmation window is displayed.
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5. To erase, click the [OK] button.

→ The [Erasing media (Drive)] window is displayed, and data erasing is started.

6. The following window will be displayed when processing is finished. Click the [OK] button.

 
Export File and Folder

The steps of exporting files and folders to a DVD/CD with File Export Utility are as follows.

 

 Note

Please confirm the status of file

- Please do not access the file that is being exported through the export utility from another application. When the file in the export
process is being accessed, an error may occur.

- When decrypting the file in the export destination, the OS operation authority is required for encrypting files, and files cannot be
decrypted without operation authority.

1. Start the [File Export Utility] window.

2. Add the file or folder to be exported with any of the following methods.

 

 Note

When selecting the file and folder of export source, please consider the restriction of export destination

The following restrictions are applied to the length of the file name or folder name of the export target. 
Therefore, before export, it is necessary to check the length of the file name or folder name to be exported to make sure it is within
the limit of export target.
In particular, when exporting folders, if the subordinate files exceed the limit, an error will also occur, which will disable the export.
Please be aware of this.

  

[About the length of file name and folder name of export target] 
The maximum length of the file name of the export target is 240 bytes (including path length) (folder separator (\) is counted as 1
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byte, and 1 character of a file name and folder name is counted as 2 bytes).
In addition, file name and folder name are specified within 64 characters (both double-byte and single-byte characters are counted
as 1 character)

- Use the menu of the [File Export Utility] window.

a. Select [Add file] from the [File] menu when exporting files. 
Select [Add folder] from the [File] menu when exporting folders.

b. → The selection window for the file to be exported is displayed.

c. Select the file or folder to be exported and click the [Open] button.

Repeat a and b when exporting multiple files.

- Drag and drop the files and folders to the [File Export Utility] window.

 

 Note

When executing in Windows Vista®, Windows Server® 2008 and Windows® 7

In Windows Vista®, Windows Server® 2008 or Windows® 7, if right-click on [Execute as Administrator] when starting the
Export Utility, drag and drop cannot be performed. But when the administrator logs on, even if it is started through [Execute
as Administrator], drag and drop can be performed.

→ The [File Export Utility] window is displayed.

When folder export is selected, the total size of files under this folder will be displayed in [Size].

3. When the input field of reasons for export is displayed, enter the reason.

4. Select [Execute export] from the [File] menu.
Depending on the policy settings, sometimes only removable disks are displayed as options for the destination drive.

5. Click the [OK] button on the execution confirmation window. 
The following describes the operations in the situation [When files and folders are exported directly]

[When files and folders are exported directly]

→ The [Select target for normal file export] window is displayed.

- 10 -



a. Select the DVD/CD drive of the target to be exported, and click the [OK] button.

The [Writing Settings] window is displayed.

b. Enter the following information, and click the [OK] button.

 
Item Name Description

[Volume Name] Enter the name of DVD/CD that is written.
The length of the DVD/CD name is no more greater than 16 characters
of single-byte capital English characters, numbers and _(underscore). 
The initial value is the year/month/day/hour/minute/second (14
characters) displayed in the [Writing Settings] window.

[Eject after writing
completed]

Select it to eject the media after the writing has finished.

[Export destination folder] Enter the created folder name when creating a folder in the DVD/CD of
the target for export.
Up to 64 characters can be entered (Both single-byte and double-byte
will be counted as one character). 
Please specify the path length including files no greater than 240 bytes
(please count folder separator (\) as 1 byte, and count 1 character of file
name and folder name as 2 bytes).
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When inserting a writable DVD/CD media, information of the DVD/CD media will be displayed (total capacity, used
space and remaining space). To display the latest information, please click the [Display Latest Media Information] button.

The [Writing] window is displayed.

c. The following window is displayed after the file export has finished. Click the [OK] button.

When accessing the DVD/CD drive immediately after writing the DVD/CD media, it is likely that the media information
cannot be viewed. In this case, please eject the media and insert it again.

1.3 Confirm the Files at Export Destination
After the export has finished, confirm the folders and files at the export destination in a list. 
Depending on policy settings, confirmation cannot be performed in Explorer sometimes. 
When it is unable to confirm in Explorer, please confirm according to the following procedure:

1. Start the [File Export Utility] window.

2. Start the [View export target] window with any of the following method.

- Select [View export files with full path] from the [Display] menu.

- Select [View export target] from the tool bar.
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→ The list of files at export destination is displayed.

3. Confirm the exported file name.

1.4 Format Drive
The drive with export prohibition specified cannot be formatted with the format function of the OS. 
To format the drive with export prohibition specified, please use this function.

The following describes the procedure of formatting a drive.

  

1. Start the [File Export Utility] window.
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2. Select [Format drive] from the [File] menu.

→The [Format drive] window is displayed.

3. Select the drive to be formatted, and click the [Format] button.

Please do not select the drive in which the OS is installed.

→ The [Format Local Disk (Drive)] window is displayed.

4. Select the format method in [Format options], and click the [Start] button.
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5. The warning window is displayed. After confirming the content, click the [OK] button.
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Chapter 2 Apply Off-line Policy
This chapter describes the following operating methods:

- Use of the Policy Application Tool to update the policy of the client (CT).

2.1 Apply Off-line Policy
This section describes how to use the policy application tool released by the administrator.

 

 Note

When the administrator releases the policy application tool in an E-mail attachment, please save the file attachment to any folder before
running it.

1. Start the Policy Application Tool released by the administrator.

→ The following window is displayed.

2. Click the [OK] button after entering the startup password given by the administrator. To cancel, please click the [Cancel] button.

→ The following window is displayed.
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3. To apply the policy, please click the [Yes] button. To cancel, please click the [No] button.

→ The following window is displayed after the policy has been applied successfully.

4. Please click the [OK] button to exit the Policy Application Tool.
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Appendix A Appendix A Message List

A.1 Message Output During Installation
 
[I401-ERR001] Systemwalker Desktop Keeper client cannot be installed. Please confirm the object OS
and Service Pack. The installation is cancelled.
 
Cause

It is installed in “Unsupported OS or Service Pack”.

 
Resolution

Please install it in “Supported OS or Service Pack”.

 
[I401-ERR003] InstConf.ini file is not found. Please specify the path of InstConf.ini file.The installation is
cancelled.
 
Cause

The specified path of InstConf.ini file is wrong when executing setup.exe.

 
Resolution

Please specify the path of the InstConf.ini file correctly.

 
[I401-ERR004] The value of %s cannot be read from InstConf.ini. Please reinstall. The installation is
cancelled.
 
Variable information

%s: any of the following section names that have failed to read.

- SvIPAddress

- SvIPAddress2

- CommPort

- SendPort

- SendPort2

- Password

- LogDirectory

- RebootAfterInstall

- ClientDirectory

- PrinterMode

- MailSendWatchPort

- MailAttachDeterrentMode

- MailAttachDeterrentPort

- MailAttachDeterrentPort2

 
Cause

The %s described in InstConf.ini cannot be read.
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Resolution

Please confirm the path and content of the InstConf.ini file.

 
[I401-ERR005] In the InstConf.ini file, the value of %s is incorrect. Please record the correct value. The
installation is cancelled.
 
Variable information

%s: Any of the following incorrect section names exists in the value.

- SvIPAddress

- SvIPAddress2

- CommPort

- SendPort

- SendPort2

- Password

- LogDirectory

- RebootAfterInstall

- ClientDirectory

- PrinterMode

- MailSendWatchPort

- MailAttachDeterrentMode

- MailAttachDeterrentPort

- MailAttachDeterrentPort2

 
Cause

The value of %s described in the InstConf.ini is incorrect.

 
Resolution

Please set the value in the InstConf.ini file correctly.

 
[I401-ERR006] Fail to copy the %s file.
It is caused because:
    -the disk capacity is insufficient;
    -the corresponding disk denies being written;
    -the file with the same name already exists;
    -the file with the same name already exists;
Please reinstall after confirmation.
The installation is cancelled.
 
Variable information

%s: Name of the file that has failed to be copied.

 
Cause

Failed to copy the file due to insufficient disk capacity or the corresponding disk denies being written or there already exists a file with
the same name.

 
Resolution

Please confirm whether the disk capacity is insufficient, or if the corresponding disk denies being written or if a file with the same
name already exists, and then reinstall it.
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[I401-ERR007] Failed to create the %s directory. 
It is caused because:
    -the disk capacity is insufficient;
    -the corresponding disk denies being written;
    -the file with the same name already exists ; etc.
Please reinstall after confirmation.
The installation is cancelled.
 
Variable information

%s: Name of the folder that has failed to be created.

 
Cause

Failed to create the folder due to insufficient disk capacity or the corresponding disk denies being written or there already exists a
folder with the same name.

 
Resolution

Please confirm whether the disk capacity is insufficient, or if the corresponding disk denies being written or if the folder with the same
name already exists, and then reinstall it.

 
[I401-ERR008] Failed to read the value of registry. Please contact the system administrator. The
installation is cancelled.
 
Cause

Fail to read the registry.

 
Resolution

This could be caused because some key value of the registry being deleted. Please contact Fujitsu technical staff.

 
[I401-ERR009] Failed to create the registry. Please reinstall after logging on as Administrator. The
installation is cancelled.
 
Cause

Fail to write registry.

 
Resolution

Please reinstall it after logging on as administrator.

 
[I401-ERR010] The user who performs installation does not have Administrator authority. Please reinstall
after logging on as administrator.The installation is cancelled.
 
Cause

The user who executes the installation does not have administrator authority.

 
Resolution

Please reinstall it after logging on as administrator.

 
[I401-ERR011] Failed to install Systemwalker Desktop Keeper Client. Please confirm the error contents
in the installation log file. Installation log file:[%s]. The installation is cancelled.
 
Variable information

%s: Name of installation log file

 
Cause

This displays when an error occurred during the installation in silent mode.
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Resolution

Please confirm the errors existed in the installation log file in the path that is displayed in the message.

 
[I401-ERR012] Failed to register the service . Please contact the system administrator. The installation is
cancelled.
 
Cause

Fail to register CT service.

 
Resolution

Please contact the system administrator.

 
[I401-ERR019] The installation of %1 has been completed, but an error occurred.
Please confirm the error contents in the installation log file.
Installation log file:[%2].
The installation is cancelled.
 
Variable information

%1: Name of installation function
%2: Name of installation log file

 
Cause

The installation has been finished, but some errors occurred.

 
Resolution

Please confirm the errors existed in installation log file in the path that is displayed in message.

 
[I401-ERR020] The Citrix XenApp has been installed. Systemwalker Desktop Keeper client cannot be
installed in the environment with Citrix XenApp installed. The installation is cancelled.
 
Cause

Citrix XenApp has already installed.

 
Resolution

The Systemwalker Desktop Keeper client cannot be installed in the environment with Citrix XenApp installed. Please install the
monitoring function of Citrix XenApp.

 
[I401-ERR101] The Systemwalker Desktop Keeper Server has been installed. Please reinstall after
uninstalling the server. The installation is cancelled.
 
Cause

Systemwalker Desktop Keeper Server has already been installed.

 
Resolution

Please reinstall it after uninstalling the Systemwalker Desktop Keeper Server.

 
[I401-ERR102] The Secure Keeper Client has been installed. Please reinstall after uninstalling the Secure
Keeper Client. The installation is cancelled.
 
Cause

The Secure Keeper client has already been installed.

 
Resolution

Please reinstall it after uninstalling the Secure Keeper Client.

 
[I401-ERR103] Failed to replace the command line. Please contact the system administrator.
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Cause

Fail to replace the shortcut of command prompt.

 
Resolution

Please modify the link target of the shortcut of command prompt to “fsw41ej1.exe” of the Windows system folder.

 
[I401-ERR104] Failed to copy the command line. Please contact the system administrator. The installation
is cancelled.
 
Cause

Fail to copy the command prompt.

 
Resolution

Please copy the command prompt manually.
Under the system of NT series: cmd.exe → fsw00ej2.exe (In system directory Example: C:\winnt\system32\cmd.exe → C:\winnt
\system32\fsw00ej2.exe)
Under 9X system: Command.com → fsw00ej1.com (In Windows directory. Example: C:\windows\Command.com → C:\windows
\fsw00ej1.exe)

 
[I401-ERR106] The previous installation/uninstallation is not completed. Please reinstall after
restarting. The installation is cancelled.
 
Cause

The computer did not reboot after the previous installation/uninstallation.

 
Resolution

Please reinstall it after rebooting.

 
[I401-ERR107] The installation parameter has been specified. Desktop Keeper client has been installed.
The installation is cancelled.
 
Cause

Please reinstall it when Desktop Keeper Client has already been installed.

 
Resolution

-

 
[I401-ERR108] The client of Base Edition is prepared to install in the terminal with Systemwalker Desktop
Keeper Standard Edition client installed. The client of Standard Edition cannot be updated through the
client of Base Edition. The installation is cancelled.
 
Cause

The client of Base Edition is to be installed in the terminal on which the client of Systemwalker Desktop Keeper Standard Edition has
already been installed.

 
Resolution

The client of Systemwalker Desktop Keeper Standard Edition cannot be updated with the client of Base Edition. Please update with
the client of Standard Edition client.

 
[I401-ERR109] The selection folder cannot specify the root directory of drive or drive other than fixed
disk. Please specify the correct folder.
 
Cause

As the selected directory, you specified a root of the drive or a drive other than the fixed disk.
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Resolution

Please specify a folder other than the root directory of a fixed disk.

 
[I401-ERR110] The Systemwalker Desktop Keeper server of old VL has been installed, Or prepare to install
the client of Standard Edition on server of Base Edition. Please upgrade the Version or Edition of
server. The installation is cancelled.
 
Cause

Systemwalker Desktop Keeper Server of older VL has been installed, or the client of Standard Edition is to be installed on the server
of Base Edition.

 
Resolution

Please upgrade the version or edition of the server.

 
[I401-ERR113] Please enter the characters within 32 bytes in the password of InstConf.ini file. The
installation is cancelled.
 
Cause

The length of the password in the InstConf.ini file exceeded 32 characters.

 
Resolution

Please enter a password with no more than 32 characters.

 
[I401-ERR117] The monitoring function of Citrix XenApp has been installed. Please reinstall after
uninstallation. The installation is cancelled.
 
Cause

The Citrix XenApp monitoring function has been installed.

 
Resolution

Please reinstall it after uninstalling the Citrix XenApp monitoring function.

 
[I401-WRN001] When the drive of log saving folder is specified as prohibited drive, the logs may not be
collected normally.
It is recommanded to specify the folder of OS installation drive.
Continue?
 
Cause

A drive that is not the OS installation drive has been specified as the folder for saving logs.

 
Resolution

It is recommended to specify the folder of the OS installation drive as the folder for saving logs.

 
[I401-WRN002] When the overwrite installation is performed for the current installed client, part of
function cannot be operated before restarting.
Please restart immediately after the installation is completed.
 
Cause

This can be displayed when the overwriting installation is performed for the client of V12.0L20 BE-V13.0.0.

 
Resolution

Please reboot after the overwriting installation has finished.

 
[I411-ERR001] IP address error. Please enter a value between 1 and 254
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Cause

Number out of range (must be from 1 to 254), or nonnumeric characters are entered in the IP address.

 
Resolution

Please enter a value within the range of 1 to 254.

 
[I411-ERR002] IP address error. Please enter a value between 0 and 255.
 
Cause

Number out of range (must be from 0 to 255), or nonnumeric characters are entered in the IP address.

 
Resolution

Please enter a value within the range of 0 to 255.

 
[I411-ERR003] Port number error. Please enter a value between 5001 and 60,000.
 
Cause

Number out of range (must be from 5001 to 60000), or nonnumeric characters are entered in the Port number.

 
Resolution

Please enter a value within the range of 5001 to 60000.

 
[I411-ERR004] IP address error. Please enter a correct value.
 
Cause

The format of IP address is wrong.

 
Resolution

Please enter a correct IP address.

 
[I411-ERR005] The password does not match. Please enter a correct password.
 
Cause

The entered password does not match with re-entered password.

 
Resolution

Please enter a correct password.

 
[I411-ERR006] The saving target of log file is incorrect. Please enter a correct value.
 
Cause

Went to the next step before entering the saving target path of the log file.

 
Resolution

Please enter a correct saving target path of the log file.

 
[I411-ERR008] The password is not entered. Please enter a password.
 
Cause

The password is not entered.

 
Resolution

Please enter the password.

 
[I411-ERR009] The characters not allowed in password are entered. The characters that can be entered
are single-byte letters and numerals, and symbols excluding the following symbols. In addition, the
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double-byte and single-byte space cannot be entered.
Characters that cannot be entered: “&”“<”“>”“|”“\”“"”“^”“~”“'”“?”“:”
 
Cause

Invalid characters are entered in the password.

 
Resolution

Please only enter valid characters in the password.

 
[I411-ERR010] The symbols not allowed in directory name are entered. The symbols excluding the
following symbols can be entered.
Symbols that cannot be entered: “#”“%”“/”“:”“*”“?”“"”“<”“>”“|”
 
Cause

Invalid symbols are entered as directory name.

 
Resolution

Please only enter valid characters for the directory name.

 
[I411-ERR012] When not coexisting with the server, the loopback address (127.0.0.1) cannot be
specified. Please enter the correct address.
 
Cause

When installing in different a PC without the installing server, loopback address (127.0.0.1) is specified as the IP address of server.

 
Resolution

Please enter correct IP address of the server.

 
[I411-ERR018] Please enter the password within 32 characters.
 
Cause

The length of password exceeded 32 characters.

 
Resolution

Please enter a password with no more than 32 characters.

 
[I411-ERR019] The port number repeated. Please enter the different values.
 
Cause

Duplicate port number.

 
Resolution

Please enter a different port number.

 
[I411-ERR020] The port number is incorrect. Please enter a value between 0 and 65,535.
 
Cause

A value outside 0-65535 or a non-numeric character has been entered.

 
Resolution

Please enter a value within the range of 0 to 65535.

 
[I411-ERR021] The length of specified folder path is too long. Please specify a path within 96 bytes.
 
Cause

The specified path is too long.
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Resolution

Please specify the path no greater than 96 bytes.

 
[I421-ERR001] The parameter cannot be read through the command line. Please reinstall after confirming
the parameter. The installation is cancelled.
 
Cause

Parameter in command line cannot be read.

 
Resolution

Please reinstall it after the parameter is confirmed.

 
[I421-ERR002] The parameter format specified in command line is incorrect. Please record in the correct
format.
ex. When specifying CT silent installation file, > Setup.exe /Silent "C:\InstConf.ini"
When not specifying the CT silent installation file, > Setup.exe /Silent "Reboot:1"
The installation is cancelled.
 
Cause

Format of the parameter is incorrect.

 
Resolution

Please enter with a correct format.

 
[I421-ERR003] The value of “Reboot” parameter is incorrect. Please enter the correct value. The
installation is cancelled.
 
Cause

The value of parameter "Reboot" is incorrect.

 
Resolution

Please enter a correct value.

 
[I431-ERR001] The Systemwalker Desktop Keeper client is not installed. Please update again after
installing the client. The update is cancelled.
 
Cause

The Systemwalker Desktop Keeper Client is not installed.

 
Resolution

Please update again after installing the Client.

 
[I999-ERR999] Error occurs. Please contact the system administrator.
 
Cause

Error is caused by the damaged installation package.

 
Resolution

Please contact Fujitsu technical staff.

A.2 Message Output During Uninstallation
 
[I402-ERR001] Failed to delete the %s file. Please contact the system administrator.
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Variable information

%s: Name of the file that has failed to be deleted

 
Cause

Failed to delete the file.

 
Resolution

Please delete the file manually.

 
[I402-ERR002] Failed to delete the log saving directory. Please contact the system administrator.
 
Cause

Failed to delete the folder.

 
Resolution

Please delete the folder manually.

 
[I402-ERR003] Failed to read the value of registry. Please contact the system administrator. The
uninstallation is cancelled.
 
Cause

Failed to read registry.

 
Resolution

This could be caused because some key value of the registry being deleted. Please contact Fujitsu technical staff.

 
[I402-ERR004] Failed to create the registry. Please uninstall again after logging on as Administrator. The
uninstallation is cancelled.
 
Cause

Failed to write registry.

 
Resolution

Please uninstall it again after logging on as an administrator.

 
[I402-ERR005] Failed to delete the registry. Please uninstall again after logging on as Administrator. The
uninstallation is cancelled.
 
Cause

Failed to delete the key value of registry.

 
Resolution

Please uninstall it again after logging on as an administrator.

 
[I402-ERR006] The user who performs uninstallation does not have Administrator authority. Please
uninstall again after logging on as Administrator. The uninstallation is cancelled.
 
Cause

The user who executes uninstallation does not have administrator authority.

 
Resolution

Please uninstall it again after logging on as an administrator.

 
[I402-ERR007] Failed to uninstall the Systemwalker Desktop Keeper client. Please confirm the error
contents in the installation log file. Installation log file:[%s]. The uninstallation is cancelled.
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Variable information

%s: Name of installation log file

 
Cause

This displays when an error occurred during the uninstallation in silent mode.

 
Resolution

Please confirm the errors existed in installation log file in the path that is displayed in the message.

 
[I402-ERR008] Failed to delete the service. Please contact the system administrator. The uninstallation
is cancelled.
 
Cause

Failed to delete the CT service.

 
Resolution

Please contact the system administrator.

 
[I402-ERR101] The password does not match. Please enter the correct password. The uninstallation is
cancelled.
 
Cause

The password is not specified in the parameter when the uninstaller starts.

 
Resolution

Please specify a password in the parameter when the uninstaller starts.

 
[I402-ERR102] Start to uninstall, but the correct password is not entered. (If you want to reinstall, please
uninstall first before installing.) Uninstallation is cancelled.
 
Cause

Password error in parameter.

 
Resolution

Please specify the correct password.

 
[I402-ERR103] The service of Systemwalker Desktop Keeper cannot be stopped. The uninstallation is
cancelled.
 
Cause

Systemwalker Desktop Keeper Client services cannot be stopped during uninstallation.

 
Resolution

The above occurs when services have no response. Please uninstall it again after rebooting.

 
[I402-ERR104] Failed to replace the command prompt. Please contact the system administrator.
 
Cause

Failed to replace the shortcut of command prompt.

 
Resolution

In the system of NT series, please modify the link target of shortcut of command prompt to “cmd.exe” of system folder. In the system
of 9X series, please modify the link target of the shortcut of the command prompt to “command.com” of the system folder.

 
[I402-ERR105] The parameter format specified in the command line is incorrect. Please record in the
correct format.
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ex. > Setup.exe /Silent "Password:[password],Reboot:1" 
The uninstallation is cancelled.
 
Cause

The parameter format is incorrect.

 
Resolution

Please use the correct parameter format.

 
[I402-ERR106] The parameter cannot be read through the command line. Please uninstall again after
confirming the parameter. The uninstallation is cancelled.
 
Cause

Failed to read the parameter from the command line.

 
Resolution

Please uninstall it again after confirming the parameters.

 
[I402-ERR107] The uninstallation parameter has been specified. The Desktop Keeper client has not been
connected. The uninstallation is cancelled.
 
Cause

Uninstallation is performed when Desktop Keeper Client is still not installed.

 
Resolution

-

 
[I402-ERR108] The previous installation and uninstallation are not completed. Please uninstall again after
restarting. The uninstallation is cancelled.
 
Cause

The computer does not reboot after the previous installation/uninstallation.

 
Resolution

Please uninstall it again after rebooting.

 
[I402-ERR109] The value of “Reboot” is incorrect. Please enter a correct value. The uninstallation is
cancelled.
 
Cause

The value of parameter "Reboot" is incorrect.

 
Resolution

Please enter a correct value.

 
[I412-ERR101] The password does not match. Please enter a correct password.
 
Cause

The password does not match.

 
Resolution

Please enter the correct password.
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A.3 Message Output During Using
 
[D101-INF001] This application is prohibited by the system administrator.
 
Cause

Intended to start the prohibited application.

 
Resolution

-

 
[D102-INF002] The system administrator has stopped the service.
 
Cause

The system administrator has stopped the service.

 
Resolution

-

 
[D1F1-INF001] Adding this file as E-mail attachment is prohibited by system administrator. (File
prohibited to be added: <File Name>)
 
Cause

The prohibited application file is to be attached to an E-mail for sending or saving.

 
Resolution

-

 
[D1F2-ERR001] Failed to send the E-mail.
(Title <SUBJECT of E-mail>)
 
Cause

The E-mail has already been sent from virtual E-mail server to E-mail server, but error occurs and the E-mail cannot be sent.

 
Resolution

The E-mail server cannot be connected due to network problems, or problem occurred on the E-mail server. It is necessary to check
the environment.

 
[D1F2-ERR002] The E-mails sent after %s may not have been sent correctly.
The E-mail server with exception cannot be found in the network.
 
Variable information

%s: Sending time

 
Cause

This could be caused because:

- The E-mail server could not be found.

- It is not SMTP communication.

- Encrypted communication is performed.

- The unsupported character code is used.

- The sending from the mailer is interrupted.

- Unexpected error occurred in the sending process.
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Resolution

Please remove the above causes and send the E-mail again.

 
[D1F2-ERR003] The E-mails sent after %s may not have been sent correctly.
An error has been returned from the E-mail server.
 
Variable information

%s: Sending time

 
Cause

Error is return from the E-mail server.

This could be caused by the reason that satisfies all of the following conditions:

- When all the E-mail addresses of sending targets are the accounts with the same domain as the E-mail server.

- When the specified address does not exist in the actual corresponding E-mail server.

- When the specified E-mail address of sending target satisfies all the conditions above.

 
Resolution

Please correct the errors on the E-mail server.

 
[D1F3-ERR001] The E-mails sent after %s may not have been sent correctly.
 
Variable information

%s: Sending time

 
Cause

This could be caused because:

- The E-mail cannot be sent due to the reasons such as shutdown during E-mail sending.

- The operation file used during E-mail analysis is not deleted.

 
Resolution

Please remove the above causes and send the E-mail again.

 
[D1F4-WRN001] Please confirm the recipient address.
After confirmation, please click the Send button to send the E-mail.
 
Cause

Intended to send E-mail to the address that is not an exclusion domain. Please send only when the recipient address is correct.

 
Resolution

Please send the E-mail after confirming the recipient address is correct.

 
[D1F4-WRN003] As the prohibited file is added as E-mail file attachment, the sending is stopped. Please
confirm whether the attachment file is correct.
 
Cause

The E-mail with prohibited file attachment is to be sent.

 
Resolution

Please send the E-mail after removing the prohibited file attachment.

 
[D1F4-WRN004] The E-mail sending is cancelled. The E-mail to be sent is saved to the "Sent" folder. When
sending again, please edit the E-mail in the "Sent" folder and then send.
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Cause

Intended to send E-mail to the address that is not an exclusion domain, but the sending is cancelled.

 
Resolution

The E-mail that is cancelled to be sent is saved to the “Sent” folder. Please edit the E-mail in the “Sent” folder and send it when sending
the previous E-mail again.

 
[D901-INF001] The print function of this application is prohibited by the system administrator.
 
Cause

Intended to use the prohibited application to print.

 
Resolution

-

 
[D901-INF002] The PrintScreen key has already been prohibited.
 
Cause

The PrintScreen key is pressed.

 
Resolution

-

 
[E001-WRN001] The printing pages have already reached the printing pages limit in one day set by system
administrator.
Printed pages: %1 / Limit of printing pages: %2
 
Variable information

%1: Total number of printed pages

%2: The prohibited number of pages set by the administrator

 
Cause

The number of pages printed at the terminal has exceeded the warning pages set by the administrator when the setting is performed
by day.

 
Resolution

Please control printing.

 
[E001-WRN002] The printing pages have already reached the printing pages limit in one week set by
system administrator.
Printed pages: %1 / Limit of printing pages: %2
 
Variable information

%1 total number of printed pages

%2 prohibited number of pages set by the administrator

 
Cause

The number of pages printed at the terminal has exceeded the warning pages set by the administrator when the setting is performed
by week.

 
Resolution

Please control printing.
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[E001-WRN003] The printing pages have already reached the printing pages limit in one month set by
system administrator.
Printed pages: %1 / Limit of printing pages: %2
 
Variable information

%1 total number of printed pages

%2 prohibited number of pages set by the administrator

 
Cause

The number of pages printed at the terminal has exceeded the warning pages set by the administrator when the setting is performed
by month.

 
Resolution

Please control printing.

 
[E001-WRN004] The printing pages have already reached the printing pages limit in one day set by system
administrator.
Printed pages: %1 / Limit of printing pages: %2
 
Variable information

%1 total number of printed pages

%2 warning pages set by the administrator

 
Cause

The number of pages printed at the terminal has exceeded the warning pages set by the administrator when the setting is performed
by day.

 
Resolution

Please control printing.

 
[E001-WRN005] The printing pages have already reached the printing pages limit in one week set by
system administrator.
Print pages: %1/Limit of printing pages: %2
 
Variable information

%1 total number of printed pages

%2 warning pages set by the administrator

 
Cause

The number of pages printed at the terminal has exceeded the warning pages set by the administrator when the setting is performed
by week.

 
Resolution

Please control printing.

 
[E001-WRN006] The printing pages have already reached the printing pages limit in one month set by
system administrator.
Print pages: %1/Limit of printing pages: %2
 
Variable information

%1 total number of printed pages

%2 warning pages set by the administrator
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Cause

The number of pages printed at the terminal has exceeded the warning pages set by the administrator when the setting is performed
by month.

 
Resolution

Please control printing.

 
[E001-ERR001 The printing pages have exceeded the printing pages limit in one day set by system
administrator, so printing is prohibited.
Printed pages: %1 / Limit of printing pages: %2
 
Variable information

%1 total number of printed pages

%2 prohibited number of printed pages set by the administrator

 
Cause

The number of pages printed at the terminal exceeds the pages of printing prohibition set by the administrator when the setting is
performed by day.

 
Resolution

Printing cannot be performed.

 
[E001-ERR002] The printing pages have exceeded the printing pages limit in one week set by system
administrator, so printing is prohibited.
Printed pages: %1 / Limit of printing pages: %2
 
Variable information

%1 total number of printed pages

%2 prohibited number of print pages set by the administrator

 
Cause

The number of pages printed at the terminal exceeds the pages of printing prohibition set by the administrator when the setting is
performed by week.

 
Resolution

Print cannot be performed.

 
[E001-ERR003] The printing pages have exceeded the printing pages limit in one month set by system
administrator, so printing is prohibited.
Printed pages: %1/Limit of printing pages: %2
 
Variable information

%1 total number of printed pages

%2 prohibited number of print pages set by the administrator

 
Cause

The number of pages printed at the terminal exceeds the pages of printing prohibition set by the administrator when the setting is
performed by month.

 
Resolution

Printing cannot be performed.

 
[E002-INF001] Accessing to this Web site is prohibited by system administrator.
(Web site URL prohibited to be accessed: <%s>)
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Variable information

%s: URL of prohibited Web site

 
Cause

The Web site to which access is prohibited is accessed.

 
Resolution

Because this Web site cannot be accessed, please do not try to access it, or ask the administrator to modify the policy.

 
[E002-INF002] Connecting to FTP server is prohibited by system administrator.
(FTP server address prohibited to be connected: <%s>)
 
Variable information

%s: prohibited FTP server address

 
Cause

Connection to the FTP server prohibited to connect to is performed.

 
Resolution

Because the FTP server cannot be connected, please do not connect to it, or ask the administrator to modify the policy.

 
[E002-INF003] Uploading files to this Web site is prohibited by system administrator.
(Web site URL prohibited to be uploaded:<%s>)
 
Variable information

%s: URL of prohibited Web site

 
Cause

Files are being uploaded to a prohibited Web site.

 
Resolution

Because uploading to this Web site cannot be performed, please stop uploading, or ask the administrator to modify the policy.

 
[E002-INF004] Downloading files from this Web site is prohibited by system administrator.
(Web site URL prohibited to be downloaded:<%s>)
 
Variable information

%s: URL of prohibited Web site

 
Cause

Files are being downloaded from a prohibited Web site.

 
Resolution

Because downloading from this site cannot be performed, please stop downloading, or ask the administrator to modify the policy.

 
[E601-INF001] The user name is prohibited by system to log on. It will be logged off by force after 30
seconds.
 
Cause

An unauthorized user name is used to logon.

 
Resolution

-
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[E601-INF002] The user name is prohibited by system to log on. It will be shutdown by force after 30
seconds.
 
Cause

An unauthorized user name is used to logon.

 
Resolution

-

 
[POCH-ERR001] Unable to execute in this computer.
Exit the program. (%1)
 
Variable information

%1: detailed error code (numerical value)

 
Cause

According to the error code, this could be caused because:

1: Intended to run the policy application tool out of the executable time of the tool.

2: Intended to operate in the computer that is not policy modification object.

3: Intended to operate in the unsupported OS.

4: Intended to modify policy in the client earlier than V14.2 version.

 
Resolution

Please take the following measures according to the error code:

1: Please do not run the policy application tool out of the executable time of the tool.

2: The program cannot be executed in the computer of non-policy change object.

3: The program cannot be executed in the unsupported OS.

4: The program cannot be used in the client earlier than V14.2 version.

 
[POCH-ERR002] Failed read program information.
 
Cause

The items set in the creation of the policy application tool (Management Console) cannot be read.

 
Resolution

There are the following possibilities:

- Please do not use the Unicode (specific) character in the folder path or file name for saving policy application tool.

If it is not caused by the above reasons, it may be because of the failure of creation, so please create again.

If it is still not working after several attempts at creation, please contact Fujitsu technical staff.

 
[POCH-ERR003] Please enter the startup password.
 
Cause

The boot password is not entered.

 
Resolution

Please enter the boot password.

 
[POCH-ERR004] Failed read program information.
Please confirm if the file name of execution file is too long.
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Cause

This could be caused because:

- The full path of executable file exceeds 260 bytes.

- The name of executable file is too long.

 
Resolution

Please take the following actions:

- Please select the folder with full path that is less than 260 bytes.

- Please execute after shortening the name of executable file. (This is for using in the temporary directory of the user.)

 
[POCH-ERR008] Startup password is incorrect.
Please enter a correct password.
 
Cause

The startup password is invalid.

 
Resolution

Please enter a correct password.

 
[POCH-ERR011] Failed to update policy.
Please contact the system administrator.
Error code: [%1] [%2]
 
Variable information

%1: Error code of DTK

%2: Error code of OS

 
Cause

According to error code, it could be caused because:

1: Failed to output policy update file.

3: The path length of the policy output destination is too long or does not exist.

4: Internal error occurred in DTK.

5: Error occurred in the OS.

6: Failure may be resulted from temporary causes such as CPU load.

 
Resolution

Please take the following measures according to error code:

1:

- C:\DTK\_Extension folder is read-only.

- The disk space of C drive is insufficient.

- C:\DTK\_Extension folder does not exist.

3: The Systemwalker Desktop Keeper is required to be reinstalled.

4: Investigation by developer is required.

5: Investigation by developer is required.

6: Please execute again later.
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[POCH-ERR012] Failed to start the program. The program may have been executed in the terminal without
Systemwalker Desktop Keeper client installed.
 
Cause

The program is likely to run in a terminal that is not installed with Systemwalker Desktop Keeper Client.

 
Resolution

Please run the program in a terminal that is installed with Systemwalker Desktop Keeper client.

 
[POCH-INF002] The policy of Systemwalker Desktop Keeper has been modified.
 
Cause

-

 
Resolution

-

 
[POCH-SEL001] Update policy.
Execute?
 
Cause

Intended to modify the policy.

 
Resolution

To modify the policy, please click the [OK] button. To stop policy modification, please click the [Cancel] button.

 
[S101-ASK001] The latest module has already been provided in the latest version. If you want to update
it to the latest version, please click "Yes". If not, please click "No". When you click "Yes", it will restart
automatically after update has completed, please close other applications first.
※ When the CT version is “1.0.0.1”.
 
Cause

The latest module has already been provided.

 
Resolution

Please decide whether to update to the latest version, and click “Yes” or “No”.

 
[S101-ASK001] The latest module has already been provided in the latest version. If you want to update
it to the latest version, please click "Yes". If not, please click "No". When you click "Yes", it will restart
automatically after update has completed, please close other applications first.
※ When the CT version is “1.0.0.7”.
 
Cause

The latest module has already been provided.

 
Resolution

Please decide whether to update to the latest version, and click “Yes” or “No”.

 
[S101-ASK002] The latest module has already been provided in the latest version. If you want to update
it to the latest version, please click [Yes]. If not, please click [No]. When you click [Yes], it needs to be
restarted after update has completed. Please close other applications first.
 
Cause

The latest module has been provided.
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Resolution

Please decide whether to update to the latest version, and click “Yes” or “No”.

 
[S101-INF001] The system administrator has terminated the application (process) by force.
 
Cause

The system administrator forces to terminate the application (process).

 
Resolution

-

 
[S102-INF002] The system administrator starts the service.
 
Cause

The system administrator starts the service.

 
Resolution

-

 
[S301-ERR001] Network error occurred when receiving the latest module. The update processing is
cancelled. Please execute again after the OS is rebooted.
 
Cause

Network error occurs when receiving the latest module.

 
Resolution

Please execute again after confirming the network environment is normal.

 
[S301-ERR002] Error occurred when writing the received module. The free disk capacity is insufficient.
Please confirm the free space of drive in the path of OS installation. The update processing is cancelled.
Please execute again after the OS is rebooted.
 
Cause

The disk capacity is insufficient.

 
Resolution

Please confirm there is available space on the installation drive.

 
[S301-ERR003] As exceeding the maximum number of connections of servers. the update module cannot
be downloaded. The update processing is cancelled. Please execute again after the OS is rebooted.
 
Cause

The maximum number of connections of servers is exceeded.

 
Resolution

The system administrator needs either to confirm the [MaxDownloadNum] of SWCTVerSettings2.ini file in the Master Management
Server and the Management Server, or execute again after rebooting the operating system. For those who are only File Export Utility
users, please either report the contents of the message to the system administrator or execute again after rebooting the operating system.

 
[S401-ERR001] Network error occurred when receiving the latest module. The update processing is
cancelled. Please execute again after the OS is rebooted.
 
Cause

Network error occurs when receiving the latest module.
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Resolution

Please check the network environment, and execute again after confirming it is normal.

 
[S401-ERR002] Error occurred when writing the received module. The free disk capacity is insufficient.
Please confirm the free space of drive in the path of OS installation. The update processing is cancelled.
Please execute again after the OS is rebooted.
 
Cause

The disk capacity is insufficient.

 
Resolution

Please confirm the available space on the installation drive.

 
[S402-ERR001] Error occurred when the log is written to file.
 
Cause

This could be caused because:

- The disk capacity is insufficient.

- The log file is saved in the drive prohibited exporting files.

- The folder for saving the log file or the log file is read-only.

- The logon user has no access authority to the folder for saving the log file.

- The disk is damaged.

 
Resolution

Please resolve the problems correspondingly as the following:

- Ensure the CT disk space is over 73MB.

- Save the log file on the disk not prohibited to export file.

- Remove the Read-only property of the log file or that of the folder for saving the log file.

- Set the authority of the logon user to have the access to the folder for saving the log file.

- Ensure the disk is running normally.

 
Writing to DVD/CD is prohibited by the system administrator.
 
Cause

The system administrator prohibits the file export via DVD/CD.

 
Resolution

When exporting a file via DVD/CD, please contact the system administrator to modify the settings of the policy.

 
The system administrator ejected writeable DVD / CD forcibly.
 
Cause

Writing to DVD/CD is prohibited by the system administrator.

 
Resolution

When exporting a file via DVD/CD, please contact the system administrator to modify the settings of the policy.

 
The system administrator prohibits the sending of this file. (This message is sometimes displayed during
operations other than E-mail sending, but it will not affect the processing, please click the OK button to
close the message.)
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Cause

The application file prohibited to be sent as an attachment is intended to be sent via E-mail attachment.

 
Resolution

-

A.4 Message Output with File Export Utility
 
[FCCA-ERR001] Failed to copy %s. The file names at sending side and receiving side are the same.
 
Variable information

%s: name of file to be exported

 
Cause

The file name of the sender is the same as that of the receiver.

 
Resolution

Please confirm the file name.

 
[FCCA-ERR002] Unable to add %s. The file with same name exists.
 
Variable information

%s: file name

 
Cause

There already exists a file with the same name.

 
Resolution

Please rename.

 
[FCCA-ERR003] The memory media that prohibits writing is used, or the drive that cannot be accessed
is specified, or the available disk space of the memory media is not enough.
 
Cause

The storage media that denies being written is used, the drive that cannot be accessed is specified, or there is insufficient disk space
of the storage media available.

 
Resolution

Please confirm whether the exported target storage media are write-protected or not.

Please confirm whether the access is available in case of network drive.

When the disk capacity of the storage media of export target is insufficient, please execute again after confirming the capacity.

 
[FCCA-ERR004] The file name with more than 218 characters (single-byte characters) cannot be specified
in the export source file name (full path).
 
Cause

The number of characters specified in the file name of export source exceeds the limit value.

 
Resolution

Specify the file name of the export source to be no greater than 218 bytes (including length of the path) and try again.

 
[FCCA-ERR005] The folder or file (%s) set in the export source does not exist. Cancel the processing.
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Variable information

%s: file name

 
Cause

The folder or file specified in the export source does not exist.

 
Resolution

Please confirm that the folder or file set in the export source exists and try again.

 
[FCCA-ERR006] Unable to copy %s. The folder at export source and export destination are the same.
 
Variable information

%s: file name

 
Cause

The folders at export source and export destination are the same.

 
Resolution

Please execute again after specifying a folder at the export destination that is different from the one at the export source.

 
[FCCA-ERR007] No authority to read the file or folder set in export source (%s).
 
Variable information

%s: name of file to be exported

 
Cause

No access authority of the file or folder set as export source.

 
Resolution

Please check the access authority of the file or folder set at the export source, and execute again.

 
[FCCA-ERR008] Multiple File Export Utilities cannot be started at the same time.
 
Cause

Attempt to start multiple file export utilities simultaneously.

 
Resolution

Please operate the file export utility that has been started.

 
[FCCA-ERR009] Unable to copy %s. The export destination folder is the subfolder of export source
folder.
 
Variable information

%s: export folder name

 
Cause

The export destination is specified to under the export source folder.

 
Resolution

Please execute again after specifying a folder at the export destination that is different from the one at the export source (including
folders under the export source folder).

 
[FCCA-ERR010] Failed to connect to the network specified as the export destination, processing cannot
be continued.
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Cause

Failed to connect to the network specified as export destination.

 
Resolution

Please execute again after confirming the network is connected.

 
[FCCA-ERR011] The file name or folder name “%s” at export source contains characters not allowed in
file name. Cancel the processing.
 
Variable information

%s: name of file or folder to be exported

 
Cause

The path of export source file contains Unicode specific character (characters that cannot be converted to Shift JIS).

 
Resolution

Please remove Unicode character (character which cannot be converted to Shift JIS character) from the path of the export source file.

 
[FCCA-ERR012] Unable to export to this memory media. Please set an allowed memory media and
execute again.
 
Cause

Intended to export file or folder to the storage media of USB device that is not allowed by policy.

 
Resolution

It is unable to export to the USB device that is not allowed to be used. Please execute again after selecting the available storage media.

 
[FCCA-ERR013] Unable to select because the specified file or folder exists on the memory media that is
not allowed to be used. (%s)
 
Variable information

%s: export source file/folder name

 
Cause

Intended to export the file or folder on the USB device storage media that is not allowed by policy.

 
Resolution

It is unable to export from the USB device that is not allowed to be used.

 
[FCCA-ERR014] Since the memory media not allowed to be used is set in the selected drive, it cannot be
displayed.
 
Cause

The drive of USB device that is not allowed by policy is selected.

 
Resolution

The file or folder in the USB device that is not allowed to be used cannot be displayed.

 
[FCCA-INF001] File export completed.
 
Cause

-

 
Resolution

-
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[FCCA-INF002] File export has been cancelled.
 
Cause

-

 
Resolution

-

 
[FCCA-SEL001] Save to specified folder after encryption.
 
Cause

-

 
Resolution

-

 
[FCCA-SEL002] Perform normal file export. Execute?
 
Cause

Intended to perform normal export.

 
Resolution

Please decide whether to execute or not.

 
[FCCA-SEL003] %s has already existed in the export destination. Overwrite?
 
Variable information

%s: Name of file to be exported.

 
Cause

%s already exists in the export destination.

 
Resolution

Please decide whether to overwrite or not.

 
[FCCA-SEL004] %s has already existed in the export destination. Overwrite?
 
Variable information

%s: Name of file to be exported.

 
Cause

There already exists a file with the same name in the export destination.

 
Resolution

Please execute again after confirming that no file with the same name exists in the export destination.

 
[FCCA-SEL005] Normal file export is being executed. Pleas wait.
 
Cause

-

 
Resolution

-

 
[FCCA-SEL006] Encryption file export is being executed. Pleas wait.
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Cause

-

 
Resolution

-

 
[FCCA-SEL007] The cancel button is clicked. Cancel the processing?
 
Cause

The cancel button is pressed during normal export.

 
Resolution

Please decide whether to cancel or not.

 
[FCCA-WRN001] Please select a file or folder.
 
Cause

Neither file nor folder is selected.

 
Resolution

Please select a file or folder.

 
[FCCA-WRN002] Please select the target folder for saving.
 
Cause

The saving target folder is still not selected.

 
Resolution

Please select a saving target folder.

 
[FCCA-WRN003] The password entered two times does not match.
 
Cause

The password that is different from the registered password is entered.

 
Resolution

Please enter a correct password.

 
[FCCA-WRN004] Please enter a password.
 
Cause

A password is still not entered.

 
Resolution

Please enter a correct password.

 
[FCCA-WRN005] Please enter an encrypted file name.
 
Cause

The encrypted file name is still not entered.

 
Resolution

Please enter an encrypted file name.

 
[FCCA-WRN006] Please enter the encrypted file name in the format that contains drive name and path
name.
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Cause

The encrypted file name is not entered with the format including drive name and path name.

 
Resolution

Please enter with the format including the drive name and path name.

 
[FCCA-WRN007] File name is not entered in the encrypted file name. Please enter a file name.
 
Cause

An encrypted file name is still not entered.

 
Resolution

Please enter an encrypted file name.

 
[FCCA-WRN008] The following characters are not allowed in a folder name or file name. /, :, *, ?, ", <, >, |
are not allowed.
 
Cause

Invalid characters are used in the folder name or file name.

 
Resolution

Please execute again after confirming the folder name and file name.

 
[FCCA-WRN009] The file name with more than %d characters (single-byte characters) cannot be specified
in the export destination file name (full path).
 
Cause

The number of characters in the export target file name exceeds the limit.

 
Resolution

Please execute again after specifying the export target file name (including path length) no greater than 218 bytes.

 
[FCCA-WRN010] The number of characters allowed for a password is %1~%2.
 
Variable information

%1: the minimum number of characters to be entered

%2: the maximum number of characters to be entered

 
Cause

The number of characters to be entered for the password exceeds the limit of characters to be entered.

 
Resolution

Please confirm the number of characters to be entered for the password.

 
[FCCA-WRN011] Please enter a removable drive in the drive name of encrypted file name.
 
Cause

As the [Display Removable Export Target Only] is set, it is unable to export to the non-removable drive.

 
Resolution

Please specify the drive type to removable drive.

 
[FCCA-WRN012] Please enter the reason for export.
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Cause

The reason for export is not input yet.

 
Resolution

Please input the reason for export.

 
[FCCA-WRN013] Lind feed code and tab cannot be used in the reason for export.
 
Cause

The line feed or tab is input in the reason for export.

 
Resolution

Please execute again after confirming the reason for export.

 
[FCCA-WRN014] Control characters cannot be used in reason for export.
 
Cause

The characters that are not allowed are used in the reason for export.

 
Resolution

Please execute again after entering the characters allowed in the reason for export.

 
[FCCD-ERR001] It is not the writable drive or drive is not found.
Cancel the processing.
 
Cause

Record data or erase media in the drive that cannot be recorded.

 
Resolution

Please connect to a recordable drive and try again.

 
[FCCD-ERR002] No blank media is set in the drive. Cancel the processing.
 
Cause

A blank media has not been placed.

 
Resolution

Place a blank media and try again.

 
[FCCD-ERR003] The media set into the drive is not a blank media. Cancel the processing.
 
Cause

The media placed in the drive is not a blank media.

 
Resolution

Place a blank media and try again.
To erase all of the data in a recorded CD-RW or DVD-RW and have to be a blank media, please select [Erase CD-RW/DVD-RW]
from the [File] menu of File Export Utility. (The File Export Utility can be used only to erase DVD-RW in Windows Vista®.)

 
[FCCD-ERR005] The media set into the drive is not supported, or it is not a blank media. Please set a
writable media and execute again.
 
Cause

The media placed into the drive does not support recording or it is a blank media.
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Resolution

Place a blank media and try again.
To erase all of the data in a recorded CD-RW or DVD-RW and have to be a blank media, please select the [Erase CD-RW/DVD-RW]
from the [File] menu of File Export Utility. (The File Export Utility can be used only to erase DVD-RW in Windows Vista®.)

 
[FCCD-ERR006] The size of file to be written exceeds the available space of target media for writing.
Cancel the processing.
 
Cause

The available space of target record media is insufficient.

 
Resolution

Make the size of the file to be recorded smaller than the available space of media, or place the file into a media that has enough available
space, and try again.

 
[FCCD-ERR007] Unable to create the image file for writing. Cancel the processing.
 
Cause

The drive specified by the user temporary directory is write-protected or it does not have enough available space.

 
Resolution

Confirm whether the drive specified by the user temporary directory is write-protected.

If the drive specified by user temporary directory does not have enough available space, ensure required space and try again.

(When exporting encrypted files, the size of available space must be 2.5 times the size of the export source file.)

(When exporting files, the size of available space must be 1.5 times the size of the export source file.)

 
[FCCD-ERR008] Writing failed.
 
Cause

Probable causes are the following:

- The media is damaged.

- The processing is terminated during record.

- System resource is insufficient.

 
Resolution

Take following actions according to the causes:

- Place a good recordable media.

- To execute re-write operation, place a recordable media.

- Exit all of the other applications, and record the CD.

 
[FCCD-ERR009] The processing has been cancelled.
 
Cause

Stop the processing.

 
Resolution

Please contact Fujitsu technical staff.

 
[FCCD-ERR010] IMAPI service has been disabled or login with Guest account. Cancel the processing.
 
Cause

IMAPI service is invalid or log on the system as a Guest account.

- 48 -



 
Resolution

In the service settings of the OS, please set the startup type of IMAPI (IMAPI CD-Burning COM Service) service to "Automatic", or
log on the system with an account other than Guest and try again.

 
[FCCD-ERR011] No media has been set in the drive or the media information cannot be obtained. Please
check the media and execute again.
 
Cause

The placed media is incompatible with the drive or the media is damaged.

 
Resolution

Place a compatible media with the drive and try again.

 
[FCCD-ERR012] Another burning software has been started, IMAPI initialization error occurred. Cancel
the processing.
 
Cause

Because another burning software is started, it is failed to initialize the IMAPI.

 
Resolution

If another burning software is started, exit it and try again.

 
[FCCD-ERR013] IMAPI device access error. Cancel the processing.
 
Cause

- Probable causes are the following: IMAPI service is invalid; Log on the system with a Guest account.

The media is damaged; The drive is not working normally.

 
Resolution

Please check the following items and try again. In the service settings of OS, please set the startup type of IMAPI (IMAPI CD-Burning
COM Service) service to "Automatic", log on the system as an account other than Guest and try again; place a compatible media with
the drive, and confirm whether the drive is working normally.

 
[FCCD-ERR014] The characters that cannot be used as volume name is entered.
The characters that can be entered are numbers, single-byte capital letters and '_'.
 
Cause

You have entered characters that cannot be used as the CD name.

 
Resolution

Only enter valid characters as the CD name.

 
[FCCD-ERR015] Unable to write with Guest account.
Cancel the processing.
 
Cause

The Guest account cannot use media record function.

 
Resolution

Please log on the system as an account other than Guest and try again.

 
[FCCD-ERR016] This OS does not support CD/DVD media writing functions of File Export Utility.
 
Cause

Execution is performed in an operating system that does not support the CD/DVD record function of Export File Utility.
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Resolution

-

 
[FCCD-ERR017] Unable to obtain drive information.
Please check if the drive is connected correctly.
Cancel the processing.
 
Cause

Probable causes are the following:

- The drive is not connected correctly.

- The drive is not working normally.

 
Resolution

Please confirm that the drive is connected correctly and working normally, and try again.

 
[FCCD-ERR018] The device of CD category does not exist. Cancel the processing.
 
Cause

The device of the CD drive type does not exist.

 
Resolution

Please try again in a client that has a device of the CD Drive type.

 
[FCCD-ERR019] No media has been set into the selected drive.
Cancel the erasing process.
 
Cause

A media that can be erased has not been placed.

 
Resolution

Place a media that can be erased and retry.

 
[FCCD-ERR022] No media that can be erased by File Export Utility has been set into the selected media.
 
Cause

A media that can be erased has not been placed.

 
Resolution

Place a media that can be erased and try again.

 
[FCCD-ERR023] Failed to erase the media.
 
Cause

Probable causes are the following:

- The media is damaged.

- Processing is terminated when erasing.

- System resource is insufficient.

 
Resolution

Take following actions according to the causes:

- Place other media that can be erased.

- Exit all of the other applications and try again.
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[FCCD-ERR024] Volume name is too long.
Up to 16 characters of numbers, single-byte capital letters and '_' can be entered.
 
Cause

The CD name is too long.

 
Resolution

Set the CD name within 16 characters.

 
[FCCD-ERR025] When writing to a CD or DVD, it is not allowed to specify a file name that exceeds 64
characters (both double-byte and single-byte will be counted as 1 character, including extension) for the
export destination file name.
 
Cause

The number of characters specified in the target export filename exceeds the limit value.

 
Resolution

Specify the target Name of the file to be exported to be no greater than 64 characters (both double-byte and single-byte are treated as
one character) and try again.

 
[FCCD-ERR026] When writing to a CD or DVD, it is not allowed to specify a folder name that exceeds 64
characters (both double-byte and single-byte will be counted as 1 character, including extension) for the
export destination folder name.
 
Cause

The number of characters specified in the target export folder name exceeds the limit value.

 
Resolution

Specify the target export folder name to be no greater than 64 characters (both double-byte and single-byte are treated as one character)
and try again.

 
[FCCD-ERR027] When writing to a CD or DVD, it is not allowed to specify a export destination file name
(full path) with more than 240 bytes (1 characters apart from separator is 2 bytes).
 
Cause

The number of characters specified in the target export file name exceeds the limit value.

 
Resolution

Please specify target file name to be no greater than 240 bytes (the separator of folder is 1 byte, file name and folder name is 1 character/
2 bytes. The separators do not include drive letters) and try again.

 
[FCCD-ERR028] The folder or file set in the export source does not exist. Cancel the processing.
 
Cause

The folder or file specified in the export source does not exist.

 
Resolution

Confirm that the folder or file set in the export source exists, and then execute the operation again.

 
[FCCD-ERR029] The media set into the drive is not a blank media (DVD-RAM) that is initialized with FAT32
format. Cancel the processing.
 
Cause

The media placed in drive is not a blank media (DVD-RAM) that was initialized in FAT32 format, or the media (DVD-RAM) of the
file has already been written, so it is unable to write.
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Resolution

Take following actions according to the causes:

- Format DVD-RAM media with FAT32 format.

- If a file or folder exists in DVD-RAM media, delete it.

 
[FCCD-ERR030] The work space for creating image file is not enough. Cancel the processing.
 
Cause

The available space in OS installation drive is insufficient.

 
Resolution

Please execute again after ensuring the available space of OS installation drive.

 
[FCCD-ERR031] Unable to eject the media.
 
Cause

Probable causes are as follows:

- The drive is controlled by another brining software.

- The drive is not connected correctly.

- The drive cannot be opened normally due to some articles.

 
Resolution

Take the following actions according to the causes:

- If the drive is controlled by another brining software, please use the eject function of the brining software to eject the media.

- Confirm whether the drive is connected correctly and no other articles exist, then press the eject button of drive to eject the media.

 
[FCCD-ERR032] When writing to media, the following characters are not allowed in folder name or file
name of export destination.
/, :, *, ?, ", <, >, | are not allowed.
 
Cause

Invalid characters are used in the folder name or file name.

 
Resolution

Confirm the folder name and file name, and then execute the Resolution again.

 
[FCCD-ERR033] Writing to %s is not supported, or the drive is not supported.
 
Variable information

%s: media name (CD-ROM, CD-RW, etc.)
※ When the media information cannot be obtained (the unsupported media (Blu-ray disk) has been placed), the media name will be
displayed as blank.

 
Cause

File export utility cannot be used to record the export target of media, or the drive is not compatible.

 
Resolution

Please confirm whether the media is recordable, or whether the drive is recordable.

 
[FCCD-ERR034] The erasing function of %s is not supported, or the drive is not supported.
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Variable information

%s: media name (CD-ROM, CD-RW, etc.)
※When media information cannot be obtained (the unsupported media (Blu-ray disk) has been placed, etc.), the media name will be
displayed as blank.

 
Cause

File export utility cannot be used to erase the media, or the drive is not compatible.

 
Resolution

Please confirm whether the media is recordable, or whether the drive is recordable.

 
[FCCD-ERR035] Another logon user is using the function of writing to media or erasing function currently.
Cancel the processing.
 
Cause

Other logon users are recording or erasing the media, so it is unable to use the file export utility to record.

 
Resolution

Please execute again after other logon users finished recording or erasing the media.

 
[FCCD-SEL001] After the erasing process, all data in the media will be deleted.
Perform erasing process?
 
Cause

Prepare to erase the media.

 
Resolution

Please decide whether to erase.

 
[FCCD-INF001] File export to media has completed.
 
Cause

-

 
Resolution

-

 
[FCCD-INF002] Media erasing completed.
 
Cause

-

 
Resolution

-

 
[FCCD-INF003] Writing to the media.
Please do not exit File Export Utility.
In addition, please do not start other applications during the process. Start time: yyyy/mm/dd hh:mm:ss
 
Cause

-

 
Resolution

-
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[FCCD-INF004] Erasing the media.
Please do not exit File Export Utility.
In addition, please do not start other applications during the process. Start time: mm/dd/yyyy hh:mm:ss
 
Cause

-

 
Resolution

-

 
[FCCM-ERR001] Unknown error occurred. Please contact system administrator.
 
Cause

Internal error occurs in Windows.

 
Resolution

Please contact Fujitsu technical staff.

 
[FCCM-ERR002] Unable to communicate with Management Server. Unable to start File Export Utility or
perform export processing.
 
Cause

Because it is unable to communicate with the Management Server, the date and time on the server cannot be confirmed.

 
Resolution

Please execute again when communication with the Management Server can be performed.

 
[FCCM-INF001] The processing has been cancelled.
 
Cause

Processing is cancelled.

 
Resolution

Please contact Fujitsu technical staff.

 
[FCCM-INF002] The policy that disable the start of file export utility has been set.
 
Cause

Policy disables the startup of file export utility is set.

 
Resolution

Please ask the administrator to modify the policy to allow the use of file export utility.

 
[FCCM-INF004] It is not the time for export. Unable to perform file export.
 
Cause

The time when file export utility cannot be used for export is set.

 
Resolution

Please ask the administrator to modify the policy to allow the use of file export utility.

 
[FCFM-ERR002] This drive cannot be formatted.
 
Cause

The selected drive cannot be formatted.
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Resolution

Please select a drive that can be formatted.

 
[FCFM-ERR003] This drive has already been deleted.
 
Cause

The select drive has already been deleted is selected.

 
Resolution

Please select a drive that can be formatted.

 
[FCFM-ERR004] Because the memory media that is not allowed to be used is set in the selected drive,
formatting cannot be performed.
 
Cause

Intended to format the drive of USB device not allowed by policy.

 
Resolution

Please select a drive that can be formatted.

 
[FCFM-WRN001] Please select a drive.
 
Cause

Either the drive is not selected, or the drive is not selected correctly.

 
Resolution

Please select a drive correctly.

 
[FCSB-ERR001] The specified parameter is incorrect.
 
Cause

Specified parameter is incorrect.
The deadline for decryption is beyond 2037/12/31.

 
Resolution

Specified parameter is incorrect.
Please specify the deadline for decryption to be a date before 2037/12/31.

 
[FCSB-ERR002] The file of copy target has already existed.
 
Cause

The existing file is specified as the copy target.

 
Resolution

Please confirm the file name of the copy target again.

 
[FCSB-ERR003] The specified file does not exist.
 
Cause

The file of the copy source does not exist.

 
Resolution

Please specify the copy source file correctly.

 
[FCSB-ERR004] No encryption file exists.
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Cause

The encrypted file does not exist.

 
Resolution

Please confirm the name of the encrypted file again.

 
[FCSB-ERR005] Work memory is not enough. Please execute again after closing the unnecessary
applications.
 
Cause

Work memory is insufficient.

 
Resolution

Please execute again after closing unnecessary applications.

 
[FCSB-ERR006] File access has been denied.
 
Cause

Access to the export source file, export target file or work file used during encryption is denied.

 
Resolution

Please confirm the following points, and execute again after solving the problems: Please check if the file or folder is opened by another
program. Please check if the file or folder is write-prohibited, or it is read-only. Please check the access authority of file or folder.

 
[FCSB-ERR007] Unable to open the file.
 
Cause

The file cannot be opened. Or the drive specified in user temporary directory is in write prohibition status, or the folder specified in
user temporary directory does not exist.

 
Resolution

Please check if the file name contains illegal characters or the file name is too long. Please open the file again after specifying a correct
file name. Or please check whether the folder specified in user temporary directory exists and whether it is in write prohibition status,
and then open it again.

 
[FCSB-ERR008] Unable to read the file.
 
Cause

Errors occurred when reading the file.

 
Resolution

Please check whether the file in processing is operated, or whether it is opened by another program. In addition, please confirm whether
there is an exception in the network environment during processing. Please execute again after solving the problems.

 
[FCSB-ERR009] Unable to create a directory.
 
Cause

The directory cannot be created. (A file with the same as the created folder exists, etc.)

 
Resolution

Please confirm the name of file to be created, and execute again after specifying a correct file name.

 
[FCSB-ERR010] The memory media that prohibits writing is used, or the available disk space of memory
media is not enough.
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Cause

The storage media prohibited to be written is used, or the available disk space of the storage media is insufficient.

 
Resolution

Please confirm whether the exported target storage media is write-protected. When the disk capacity of the exported target storage
media is insufficient, please execute again after ensuring the capacity.

 
[FCSB-ERR012] The size of file after encryption exceeded 2,140,000,000. Cancel the processing.
 
Cause

The file size after encryption has exceeded the limit.

 
Resolution

Please execute again after specifying the file size after encryption to be a value smaller than 2,140,000,000 bytes. The file size after
encryption is about 130,000 bytes larger than the original one.

 
[FCSB-ERR013] The work space for creating encryption file is not enough. Cancel the processing.
 
Cause

The available space of the drive of the export target or the drive specified in the user temporary directory is insufficient.

 
Resolution

Please execute again after ensuring the available space of the drive of the export target and the drive specified in the user temporary
directory.

 
[FCSB-ERR014] The available space of the target drive for encryption file export is not enough, or the
drive of export destination cannot be accessed. Cancel the processing.
 
Cause

The drive of export target cannot be accessed, or the available space of the drive specified in user temporary directory is insufficient.

 
Resolution

Please confirm whether the drive specified as export target can be accessed.
When the available space of the drive of export target and the drive specified in user temporary directory is insufficient, please execute
again after ensuring the space.

 
[FCSB-ERR015] Failed to delete the operation file used during encryption. Cancel the processing.
 
Cause

Fail to delete work file used during encryption. It might be caused by the following: the access authority to the specified folder in user
temporary directory is modified.

 
Resolution

Please confirm the access authority to the specified folder in user temporary directory and execute again.

 
[FCSB-ERR016] The file name or folder name at export source contains invalid characters. The following
characters cannot be used as folder name. /, :, *, ?, ", <, >, | are not allowed.
 
Cause

The name of export source file or folder contains invalid characters.

 
Resolution

Please confirm whether the file name contains invalid characters, and execute again.

 
[FCSB-ERR017] When logon with the user ID containing Unicode specific characters (characters cannot
be converted to Shift JIS), encryption export to CD or DVD media cannot be performed.
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Cause

Unicode specific character (characters that cannot be converted to Shift JIS) is contained in user ID.

 
Resolution

Please change the target for encrypted export to the media other than CD/DVD and perform export.

 
[FCSO-ERR001] The total file size exceeded the maximum value of file size that can be exported at one
time. The maximum value of file size that can be exported at one time is %d bytes.
 
Variable information

%d: the maximum value of the size of file that can be exported at one time

 
Cause

When the policy of file export log is set to "Get" and "Original File Backup", the size of file to be exported has exceeded the maximum
value of the size of file that can be exported.

 
Resolution

Please select the export source file that is smaller than the maximum size of the file that can be exported at once and execute again.

 
[FCSO-ERR002] The maximum value of the size of a single file can be exported is exceeded. The maximum
size of a single file that can be exported is %d bytes.
 
Cause

When the policy of file export log is set to "Get" and "Original File Backup ", the single file to be exported has exceeded the maximum
value of a single file that can be exported.

 
Resolution

Please control the size of the file to be smaller than the maximum value of the size of file that can be exported at one time.

 
[FCSO-ERR003] The maximum value of the number of files can be exported at one time is exceeded. The
number of files that can be exported at one time cannot exceed %d.
 
Cause

When the policy of file export log is set to "Get" and "Original File Backup", the number of files to be exported has exceeded the
maximum value for the number of files that can be exported at one time.

 
Resolution

Please select a number of files smaller than the maximum value for the number of files that can be exported at one time and execute
again.

 
[FCSO-ERR004] The work space required for exporting files is not enough. Cancel the processing.
 
Cause

When the policy of file export log is set to "Get" and "Original File Backup", the disk space required for Original File Backup is
insufficient.

 
Resolution

Please check the available space of drive that is specified during CT installation, where the folder at log export destination is located.
The following available space is required: The maximum required available space is 2.5 times of the total size of export source file
during normal export is 3.5 times of the total size of export source file during encrypted exporting.

 
[FCSO-ERR005] The export source file or folder is not found. Cancel the processing.
 
Cause

Error occurred while backing up the original. Maybe the export source file or folder has been deleted.
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Resolution

Please check whether the file or folder set as the export source exists, and execute again.

 
[FCSO-ERR006] Error occurred during file export. Cancel the processing.
 
Cause

Error occurred while backing up the original. It may be caused by the following: The source file or folder for export has been deleted.
Export source file or folder has no access authority. The log export folder specified during CT installation has been deleted. The
authority of modifying log export folder specified during CT installation is not available.

 
Resolution

Please confirm the following content, and execute again. The source file for export exists. The authority of reading export source is
available. The log export folder specified during CT installation exists. The authority of modifying log export folder specified during
CT installation is available.

 
[FCSO-ERR007] Access to the export source file is denied. Cancel the processing.
 
Cause

Error occurred while backing up the original. It may be caused by the following: The authority of reading the export source file is not
available. The source file or folder for export has been deleted.

 
Resolution

Please confirm the following content, and execute again. The authority of reading the export source file or folder is available. The
source file or folder for export is not deleted.

 
[FCSO-ERR008] The file encrypted in EFS format is contained in export source file. The file encrypted
with (%s) EFS format cannot be exported.
 
Changeable information

%s: Name of export source file

 
Cause

When policy of file export log is set to “Get” and “Original File Backup”, the files encrypted in EFS format are intended to be exported.

 
Resolution

Please execute again after performing any of the following processing. Delete the files encrypted in EFS format from export objects.
Cancel the encryption of files encrypted in EFS format.

 
[FCSY-ERR001] The specified path for saving manuals is not found.
 
Cause

The path for saving the specified manual cannot be found.

 
Resolution

Please contact Fujitsu technical staff.

 
Failed to write the file.
 
Cause

The available space of disk is insufficient.

 
Resolution

Please execute again after ensuring the disk capacity of CT.
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A.5 Message Output When Using Maintenance Command
 
[E701-ERR001] Administrator authority is required to set this option.
 
Cause

The setting of option is incorrect.
Or this option cannot be used because the current Windows user does not have Administrator authority.
The option that requires Administrator authority exists.

 
Resolution

Please confirm whether the setting of the option is correct.
If the setting of the option is correct, please confirm whether the Windows user logs on as Administrator.

 
[E701-INF001] The command has ended.
 
Cause

It will be displayed when the command ends.

 
Resolution

-
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Glossary
 
CT

This refers to computers at the lowest level managed by Systemwalker Desktop Keeper. Policy can be set in the CT unit.

 
CT Version

This is the version of Systemwalker Desktop Keeper CT installed on the computer.

 
Disc at Once Closed

Burn the CD-R and CD-RW in disk mode, and write all data in one session. Adding data to the disk cannot be performed later.

 
PMA (Program Memory Area)

This indicates an area on a CD-R or CD-RW for temporarily saving the track number and start/end position (TOC of session) when
writing a track in a session that has not yet closed.

 
TOC (Table Of Contents)

This indicates the management information recorded on a CD-R or CD-RW, such as the number of tracks, start position and the total
size of the data area, etc.

 
Track at Once Open

Burn the CD-R or CD-RW in track mode. Data can be added to the disk the next time unless the capability of the disk is full.

 
Track at Once Closed

Burn the CD-R/CD-RW in track mode. Adding data to the disk cannot be performed the next time.

 
UNC(Universal Naming Convention)

This is the method used to indicate the location of resources on a Windows Network environment.

 
Self-Decrypting Encryption

This is the encryption type that can be created by the Export Utility on the computer with Systemwalker Desktop Keeper CT installed.
Files can be decrypted by running the encrypted file even on the decryption computer without Systemwalker Desktop Keeper installed.
(The .EXE file of the decryption program has been attached to the encrypted file.)

 
Backup Management Server

This is the backup server used for getting user policy when the management server connected to the client (CT) has an exception.

 
Drive Letter

This indicates the drive information in the CT. (For example: "A" indicates the A drive. "D" indicates the D drive.)

 
Blank Media

The media types CD-R, CD-RW, DVD-R and DVD-RW without any information, including the volume label being recorded, are
called blank media.

 
Export Utility

This is a utility used to file export after an encrypted file has been created. The destination for saving the encrypted file can be specified
to any drive or folder on the local computer.

When exporting a file from the computer installed with Systemwalker Desktop Keeper CT to a removable drive, if the drive has been
suppressed, it is unable to export from Explorer.
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When there is a need to export files to a removable drive, the Export Utility installed in the CT can be used to export files to the
suppressed removable drive. In addition, the exporting file can be a self-decrypting file according to the settings of the management
console.

 
Removable Device

The following media that are recognized according to drive letter are called removable devices. (In Windows OS, this media is displayed
as "removable device" in "My Computer".)

- Floppy disk

- External hard disk

- MO

- USB memory

- Compact flash memory
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